
We all know what a page looks like. Taller than it is wide, type with graphics,

in color or black-and-white. And for five hundred and fifty years, this is the

way pages were—until the age of the Internet. 

But it’s time to turn the page. 

The page is no longer portrait, it’s landscape. News, business reports, pre-

sentations, mail, research, even catalog shopping—the screen delivers it all.

Print is now a by-product of the communication process, manufactured to di-

rect our audiences to a URL, where pages change 24/7.  

The page isn’t flat any more, and cross-media design suites are starting to

appear, engineered to let designers move back and forth between applications

quickly, easily and effortlessly. The page isn’t just a blend of static words and

pictures—both text and images can come alive, adapting to three dimensions,

moving and frolicking like children at a playground, disappearing and reap-

pearing like politicians at a fundraiser.

In today’s world of instantaneous digital communication, content creators

must think about their pages in dual layout mode: how will they work on

screen, and how will they look in print? And one must complement the other. 

We control the horizontal. We control the vertical.

The page has turned 

THE MODERN PAGE WAS HANDED DOWN TO US

by Gutenberg and all the printers who followed him, designed

to present type in the most readable format possible. But today’s

page is more likely to go first to a computer monitor, not a press,

and to be built around images, not text—which may even be

movies, animations, virtual reality, or full 360° panoramas. With

a new generation of cross-media page design tools now being

developed, and an Information Age that relies less on paper than

on digital screens, it’s time to rethink the definition of a “page”.

by Dan Brill 
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S U I T E  S U C C E S S
Corel was years ahead of the market when it started selling its
CorelDraw Graphics Suite as a package back in the early 1990s.
Who knows? Perhaps if Corel had jumped into Mac development
sooner, things might have turned out differently. But Windows
users’ lack of print knowledge, combined with their propensity for
using features and fonts which PostScript couldn’t handle, essen-

tially sealed CorelDraw’s fate as a high end graphics application,
and in retrospect, that’s a shame. Yet, the company gamely carries
on, with CorelDraw Graphics Suite 12 for Windows set for Febru-
ary release.

But for the Big Four—Microsoft, Apple, Adobe and Macrome-
dia—the “suite” has become the standard. Microsoft Office Pro-
fessional Edition, which bundles Word, Excel, Access, Power-

Photoshop CS introduces 
‘instant Hockney’
by Ron Giddings (giddings@rgiddings.com)

eas to blend with larger, less detailed ones. 
If you really must blend by hand, you can 
save your piece as aligned layers. 

Because we have moved beyond the 
realm of the capabilities of a single lens,
Photomerge also allows us to correct the
‘bow-tie’ distortion usually present in
panoramic shots, and to choose where the
‘vanishing point’ is in our new composition.

By the way…Photoshop CS now handles
image sizes up to 300,000 x 300,000 pixels
(“Enable Large Document Format” in Prefs).
That’s a lot of space to fill—100 x 100 feet at
250 dpi!—real art gallery size. 

And Mr. Hockney? Well, in 2000 he went
on to insult painters and art historians every-

where by declaring that Renaissance
painters used mirrors and lenses as

aids to drawing. Nobody could
draw that accurately without a

camera lucida! 
Oh, wow!

If you’re looking for straight streets to align, don’t
start with places like Bruge, Belgium. The streets
are all curved and buildings can be 
more than one color!

British painter/messiah David Hockney
insulted photographers everywhere in the
mid-1980s when he ‘discovered’ photo
collage and proclaimed that “all ordinary
photographs are taken by a one-eyed frozen
man”. His was ‘total-vision’ and consisted 
of  4x6” snapshots, all taken from one spot
and glued together into one large piece. 
Oh, wow!

Today, in Photoshop CS, we have Pho-
tomerge (which you will find under File>Au-
tomate>Photomerge) to blend our photos
seamlessly. Not just QuickTime VR-type
panoramas, but large—very large—composi-
tions. Hockney’s pieces are now examples of
what not to do in shooting for collage. One

useful thing we can learn from Hockney’s
collages is that the pictures won’t line up if
you keep tilting the camera. A tripod isn’t al-
ways available, but we should try to keep the
horizon reasonably horizontal in the
viewfinder. Equally important to realize is
that brightness will change from photo to
photo if you leave the camera’s exposure on
Automatic—dark areas will be brightened
and light ones darkened. So set exposure
manually and leave it at the same setting for
all the ‘snaps’ in a series. 

As long as your pictures overlap by 15 to
30%, Photomerge does a remarkable job of
lining them up, and—with Advanced Blend-
ing on—choosing smaller, more detailed ar-
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Point, Publisher and Outlook, is a mainstay in the Windows cor-
porate world. Apple continues to woo consumers to OS X with its
family of creative utilities, the most recent introduction being 
iLife ’04—iPhoto 4, iDVD 4, iMovie 4, iTunes 4.2, and the newly
released GarageBand for wannabe musicians (although, as Gene
Gable’s recent article at www.creativepro.com asks, wouldn’t it be
“suite” if Apple was also developing software for the professional
publishing market?). 

When it comes to competing for users, forget about product
feature comparisons. The focus today is on selling the digital en-
vironment—along with the “digital lifestyle”. 

However, what’s of prime interest to graphic designers, web
designers, publishers, or anyone who creates pages for a living is
what Adobe and Macromedia have to offer. Alas, Quark is con-
spicuously absent from this list, as it struggles to prop up its still-
significant user base with a limp version 6. Its “dual layout” con-
cept for print and the Web attempted to address the cross-media
creation conundrum, but that fell pitifully short.

Macromedia continues to move in the right direction with the
improvements it has made in its Studio MX 2004 Web develop-
ment suite of Dreamweaver, Flash, Fireworks and FreeHand, al-
though the new offering has met with mixed reviews. Given that

With Adobe’s Creative Suite
upgrade, virtually every facet of
InDesign received a facelift,
but unquestionably the most
significant change is the ability
to add rich media to any
page—video, animation, or
sound. Graphic designers who
took their first steps in print
have by now also picked up
web design skills, and for
them, stepping into InDesign’s
rich media world should be a
breeze.

Many reviews have been
written on InDesign CS. So, in-
stead of repeating what’s al-
ready been covered, we decid-
ed to demonstrate how easy it
is to add sound and video to
the design palette, using a
page layout program originally
created for printing.

A few months ago, when
InDesign CS was still in the
beta-testing stage, one of our
clients—a real estate agent—
approached us looking for a
better solution for sales pre-
sentations. Most real estate in-
formation is still communicat-

ed through faxes, with tiny pic-
tures of properties and feature
sheets that are often incom-
plete, although occasionally an
agent will distribute a CD with
photographs. A few use the
Web to let clients see photos
online or to e-mail HTML-
based documents. But HTML
poses several problems—end
users must have HTML en-
abled in their mail programs;
these pages are slow to load (a
surprisingly high percentage of
agents still use dial-up connec-
tions); and the image resolu-
tion in HTML pages is poor, as
is the quality of the printouts. 

Downloadable PDFs with
embedded rich media seemed
like the ideal solution, since
most agents have digital cam-
eras and can supply digital
photos of properties. And
most of our design projects
call for printed materials and
web design (lately, in fact, in
the reverse order). InDesign
provides the solution for both.
But what about rich media pro-
duction?

by Lidka Schuch (lidka@studio-l.com), with thanks to 

James Belardo, Grapevine Graphics, for technical assistance 

with panorama creation

Our real estate publication was designed
much like a website, by starting with a
home page, figuring out the number of links
and pages, and deciding what kind of rich
media could realistically be used. We had to
bear in mind that houses can get sold
quickly and that the layout should include
only the elements that an agent can supply
easily. We settled on two versions: one with
slide shows and music, and an upscale one
with slide shows, music, and a 360° panora-
ma—as long as the agent was able to sup-
ply the required material. To produce these
two variations for initial presentation, we
used a 360° panorama of one of the houses
in our neighbourhood.

How to make a rich media PDF
in InDesign CS 

This project did not require
any extensive video or sound
editing, so after spending a cou-
ple of days playing with iPhoto,
QuickTime Pro and The VR
Worx, we decided to do this job

entirely in-house. It was simple
and the deadline was far-off—a
perfect opportunity to jump into
a new area. The steps illustrated
here show how we produced the
final 2.6MB rich PDF.

1 PLAN PAGES LIKE A WEBSITE
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this major upgrade has added a considerable number of enhance-
ments, some of these criticisms may be a bit unfair. 

Dreamweaver’s improved browser validation, which checks
compatibility for Explorer, Netscape, Safari, Mozilla, and Opera,
should be applauded. Its new built-in graphics editing tools
streamline the content creation workflow; ASP and PHP pro-
gramming upgrades plus new FTP security features should be
welcome additions. And the ability to simply copy and paste from
Microsoft Excel or Word into a web page is a handy new feature.

Flash MX now includes new shortcuts for setting behaviours,
as well as easier ways for third party developers to build Flash ex-
tensions; and a new import function makes it much simpler to
add Adobe Illustrator and PDF content.

As well, Macromedia’s programmers have concentrated might-
ily on delivering improved performance across the board. Al-
though some of these changes have disturbed a few old users, MX

2004’s coordinated user interfaces and tighter integration overall
demonstrate that Macromedia understands the importance of
unifying its whole environment. 

All of which is fine for creating screen pages, but what about
print? The press may not be king of the hill any more, but ink on
paper isn’t just going to disappear. 

That’s where Adobe has a definite upper hand. In a future
where creators will have to build and output sophisticated pages
both for the screen and for print, only Adobe has the tools to pro-
duce both.

A L L- P U R P O S E  PA G E  C R E AT I O N  S O L U T I O N
When Adobe was planning Adobe CS, its product managers did
some research on how page creation workflows operate in the real
world. What they discovered was that, no matter what size the
company, big or small, creative projects are produced by work-

Any document that can be exported or saved
as a QuickTime movie or a Flash animation
can be placed in InDesign CS. To create slide
shows, we used iPhoto, Apple’s free software
which is included with the Mac operating sys-
tem. Just import the pictures, set the slide
show options, add music, and export it as a
QuickTime movie. To create a 360° panorama,
we purchased a panoramic tripod head—
Kaidan was our choice. For software,  we used
The VR Worx by VR Toolbox. There are numer-
ous panorama creation programs on the mar-
ket right now, but this was both the least ex-
pensive and simplest one we could find.

2 DESIGN GRAPHICS AND RICH MEDIA 



The layout was then created in InDesign, incorporating all
text, graphics, and rich media objects. This process was
not much different than designing a publication for print.
Below are a few basic pointers on using InDesign’s inter-
active tools and capabilities:
• options for movies and buttons may be found in the

Interactive flyout menu found in the Object pulldown
menu 

• options for bookmarks and hyperlinks may be accessed
through the Bookmarks and Hyperlinks palettes, found
in the Window pulldown menu

• to make buttons or text link to a specific place on a
page or just to the page itself, a bookmark must be
made for this page. Select the graphic or text or page in
the pages palette and create a new bookmark using the

Bookmarks palette command. Then use the Button
Options dialog window to make a button or text link go
to the bookmarked page or specific place on the page

• a basic rule of thumb on creating panoramas is that the
quality of stitching depends on the number of pictures
used, and the number of pictures depends on the focal
length of the lens; for example, 24 photos will produce
the best results if they are taken with a 50mm lens, but
if the lens’ focal length is 35mm (wide lens), only 18
photos are needed

• once it is activated, a rich media object will always stay
in front of other elements, so don’t attempt to place
text or pictures in front of a movie—this object will be
hidden behind the movie as soon as a user plays it, and
it will stay there permanently

groups of five to nine content creators. This was the model Adobe
used to design its Creative Suite. (They also confirmed that not
only do creative pros prefer Macs—which is no big revelation—
but that Mac people are generally horrified at being forced to go
through a “product activation” procedure, which is why they qui-
etly made sure the Mac version of CS has no such requirement.)
The Premium edition includes Photoshop 8, Illustrator 11, InDe-
sign 3, GoLive 7, and Acrobat 6 Professional—but with that many
version numbers bouncing around, Adobe preferred to simply tag
“CS’ on the end of each.

In addition to more tightly integrated user interfaces, one com-
mon environment for managing images and color, a single regis-
tration code, and the new Version Cue for project collaboration,
what Creative Suite offers is the ability to produce high quality
pages for both print and screen without ever leaving the Adobe
workspace. This is something which can’t be matched by Macro-
media, Microsoft or Apple (or Quark or Corel)—and an abun-
dance of new features in each application make the Premium edi-
tion well worth the CDN$1,139 upgrade price.

InDesign is undoubtedly the queen of this retinue. Version 3

adds a much-needed Flattener Preview—especially good for in-
specting those tricky areas where vector elements meet up with
rasters—as well as a Separations Preview palette for viewing both
process and spot color separations, checking overprints and
knockouts, and even fiddling with blacks. Both these new features
should make printers happier.

Designers should like productivity improvements such as Doc-
ument Presets for storing any number of common document se-
tups; collapsible palettes that let you save screen space; a new Info
palette that shows word, line and paragraph counts for text, or file
type, color and effective resolution information for images; nested
styles for saving variations on character styles; the important addi-
tion of the Pathfinder palette found in Illustrator and Photoshop;
and a new Story Editor tool, which speeds up editing long docu-
ments. And speaking of speed, Adobe’s claims about making In-
Design run substantially faster are true—this version outperforms
its predecessor by a wide margin. 

InDesign 2 was already far more advanced than QuarkXPress,
so this update just emphasizes the gap. There’s no point in rub-
bing more salt in the wound—just go online and read the re-

3 CREATE PAGES IN INDESIGN
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How to make a rich media PDF in InDesign CS (cont.)



views. But to make sure that Adobe also knows where it can still
improve this version, let’s list some problem areas. 

The most glaring omission is the inability to save InDesign
CS files back to InDesign 2 (and even if there was, it would re-
quire a v2 plug-in, which doesn’t exist yet). This means there’s no
way to exchange InDesign documents with someone who hasn’t
upgraded. 

Right behind this is Adobe’s removal of the Save as HTML
option. Internet-bound InDesign pages can now only be export-
ed to GoLive. This idea may have looked like a good idea to the
marketing department, but it’s an unpopular decision with Web
developers, for whom eliminating HTML export is like taking
PDF away from print publishers.

Other bothersome points: the Go to Page command still
drops you smack in the middle of a page instead of at the top,
where you would logically expect to be; inset values change
whenever you skew a frame with asymmetric insets; problems
with printing when you place a native Illustrator (.ai) graphic,
like black-to-white gradients that reverse direction (which cor-
rects itself if the file is saved as EPS); no decent tools for cleaning

The only PDFs that can play embedded rich media are those creat-
ed as version 1.5 documents (which are only supported in Acrobat 6
or Adobe Reader 6). End users need both the latest Reader and
QuickTime 6, so the broader the audience, the more likely it is that
alternate versions of the same publications without rich media
(which can be opened in older versions of Reader) will have to be
created. As well, the PDF 1.5 Reader still has a few bugs and incom-
patibilities (mostly on the Mac). On the Mac, Acrobat 6 and Adobe
Reader 6 have a problem displaying the final PDF in full screen
mode. And if you embed a movie to play within the document lay-
out (not in the floating window), the Controller Bar is displayed on
every page. But InDesign 3 is, after all, the first implementation of
rich media and print convergence. Adobe will likely iron out these
bugs soon with a patch or an upgrade. 

up text when you import, and no way of saving and applying a
“cleanup” style sheet; two Edit Originals commands in the Key-
board Shortcuts pulldown menu: one that works any time, and
another that only works when the Links palette is open—go fig-
ure!; no Text Wrap options for Inline Frames; a Duplicate com-
mand that always offsets an object by .25” horizontally and .25”
vertically, with no way to change it; and some completely inex-
plicable default settings for color management. 

What else is missing? How about object styles, and table
styles, and an outline preview, as in Illustrator? And it sure would
be nice to have a simple “Do Again” command, and to be able
to share libraries across all Adobe applications. 

C R O S S - M E D I A  PA G E S  I N  R I C H  P D F
But all these minor aggravations will be almost forgotten when
you discover the possibilities opened up by InDesign’s new abili-
ty to produce cross-media pages in rich PDF. 

Adobe has barely made any noise at all about this, which is
somewhat baffling since it is probably the single most exciting
new feature in InDesign CS. Adobe Reader 6 and Acrobat 6 can
now play video, virtual reality, Flash animations and other rich
media supported by the PDF 1.5 specification. The missing in-
gredient was an application for designing and exporting rich me-
dia pages—and now we have it.

The technique is no more difficult than designing for print
(for more details, see Lidka Schuch’s How to make a rich media

PDF tutorial), and the potential for cross-media project creation
is unlimited. Just imagine catalogues and brochures where users
can turn 3D products 360 degrees and zoom in on them (and in
which prices may be dynamically updated); e-books that come to
life with animations and sound tracks; tutorials or manuals that
walk you through instructions step-by-step, with voiceovers; per-
sonal albums that capture not only still pictures and important
dates and notes but also video and audio; music shorts with
lyrics, interviews and live recordings; complete websites that
don’t even require a Web connection—and in every case, PDF
also supports interactive forms, customizable contents pages,
passwords for security, and, of course, the ability to print out
pages with crisp text and full color.

If ever there was a compelling reason for content creators to
focus on screen pages, this is it. 

T E C H N O - C O N F L U E N C E  I S  O N LY  A N  U P G R A D E  A WAY
The bad news is that all this will be of little use to you if you
aren’t working on the latest hardware and software. But the good
news is that pages for any kind of operating system, digital device,
or Web application are only an upgrade away.

“Convergence” is an inadequate metaphor for cross-media
pages—it’s not about meeting at a single point in time and space.
It’s about techno-confluence—streams of existing technologies
that overlap, while new ones continue to be invented every day.

4 EXPORT AS PDF
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